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Introduction  
 
Microsoft Office 365 for small businesses is a set of Web-enabled tools that lets you 

access your e-mail, important documents, contacts and calendars from virtually 

anywhere and on almost any device. Designed for organisations with 5 to 50 staff, the 

service brings together online versions of the best communications and collaboration 

tools from Microsoft plus Microsoft Office Web Apps at a price that small businesses 

can afford. Office 365 works seamlessly with the programs you already know and use 

— Microsoft Outlook, Microsoft Word, Microsoft Excel and Microsoft PowerPoint. This 

is the much-anticipated cloud service that gives small businesses the capabilities and 

efficiencies to grow and target more rapid success.  

Powerful security features from Microsoft Corp. help protect your data, and when the 

service is released for general availability, it will be backed with a 99.9 percent uptime 

guarantee. Office 365 was designed to be easy enough for small businesses to run 

without specialized IT knowledge.  

Why Office 365 is Right for Your Organisation 

Virtually Anytime, Anywhere Access 

Office 365 helps you access your e-mail, important documents, contacts and calendar 

on nearly any device from almost anywhere. It frees you to work where and when you 

choose, allowing you to respond to important requests right away, no matter where 

you are. Because you can use your mobile device to access e-mail and documents, 

you won’t have to hurry back to the office (or look for a Wi-Fi hot spot if you are 

using your computer). When traveling, you can access your e-mail and even edit 

online documents from most popular Web browsers.
1
  

Easy to Use 
Office 365 is easy to try, simple to learn and straightforward to use. It works 

seamlessly with the programs you know and use most, including Outlook, Word, Excel 

and PowerPoint. With Office 365, you can choose which tools to use. 

Improved Collaboration 
With Office 365, you can create a password-protected portal to share large, hard-to-

e-mail files both inside and outside your organization, giving you a single location to 

find the very latest versions of files or documents, no matter how many people are 

working on them.  

Security and Reliability 
Powerful security features from Microsoft help protect your data, and Office 365 will 

be backed with a 99.9 percent uptime, financially backed guarantee when 

commercially released (general availability). Office 365 helps safeguard your data with 

enterprise-grade reliability, disaster recovery capabilities, data centers in multiple 

locations and a strict privacy policy. It also helps protect your e-mail environment with 

up-to-date antivirus and anti-spam solutions. 

                                                      
1
 Access from mobile devices requires Wi-Fi capability or depends on carrier network 

availability. 
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Office 365 Services Overview 

E-Mail, Calendar and Contacts 
 

 
Office 365 provides you with access to e-mail, calendar and contacts from virtually 

anywhere at any time on desktops, laptops and mobile devices — while helping to 

protect against malicious software and spam. 

 Easily manage your e-mail with 25GB mailboxes, and send e-mails up to 

25MB in size. 

 Work from almost anywhere with automatically updated e-mail, calendar 

and contacts across devices you use most, including PCs, Macintosh 

computers, iPhone, Android phones, Blackberry smartphones,
2
 Microsoft 

Windows Mobile, and Windows Phones
3
 

 Connect with Microsoft Outlook 2010 or Office Outlook 2007 and use all the 

rich Outlook functionality you already know and use, whether you are 

connected to the Internet at home or in the office or are working offline.  

 Access your e-mail, calendar and contacts from nearly any Web browser 

while keeping a rich, familiar Outlook experience with Outlook Web App. 

 Use your existing domain name to create customized e-mail addresses 

powered by Exchange Online (e.g., mark@contoso.com). 

 Easily schedule meetings by sharing calendars and viewing them side by 

side, seeing your colleagues’ availability and suggested meeting times from 
your calendar. 

 Help protect your organization from spam and viruses with Microsoft 

Forefront Online Protection for Exchange, which includes multiple filters and 

virus-scanning engines. 

Team Sites and Public Websites 

 

SharePoint Online helps you create sites to share documents and information with 

colleagues and customers. It lets you do the following: 

 Work together effectively by sharing team documents and tracking project 

milestones to keep everyone in sync 

 Keep your team’s important documents online so the latest versions are 
always at hand 

 Provide all team members with online access to critical business information 

whenever and wherever they need it 

 Easily protect critical business information by controlling who can access, 

read, and share documents and information 

 Design and maintain a simple professional-looking public website with a 

custom domain name (e.g., www.contoso.com) 

                                                      
2 Users of Blackberry Internet Service get push e-mail and can add calendar and contacts to their 

Blackberry device through a wired sync with Outlook on the PC. 
3
 Access from mobile devices depends on carrier network availability. 

mailto:mark@contoso.com
http://www.contoso.com/
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Office Web Apps  

 

Office Web Apps are convenient online companions to Word, Excel, PowerPoint and 

Microsoft OneNote that offer you an easy way to access, view and edit documents 

directly from your Web browser. 

 Simultaneously edit Excel spreadsheets and OneNote notebooks with others 

in real time and see exactly who is editing and viewing your documents. 

 Access and view files from your mobile device. 

 View documents in high fidelity.  

 Ensure that viewers see files with consistent formatting when moving 

between Office Web Apps and desktop Office applications. 

Instant Messaging and Online Meetings 

 

Microsoft Lync helps you find and quickly connect with the right person from within 

the Office applications you already use. 

 Find and connect with colleagues and customers from virtually anywhere via 

rich presence, instant messaging, audio-video calls and online meetings. 

 Use the presence indicator to see when co-workers and partners are online 

and available. 

 Make PC-to-PC voice and video calls with colleagues and customers. 

 Conduct rich online meetings — including audio-, video- and 

webconferencing — with people both inside and outside your organization. 

 Share your desktop, online whiteboards and presentations with colleagues 

and partners inside and outside your organization. 

 Click to communicate with other users of Office 365, Microsoft Windows Live 

and MSN Messenger. 
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About My Office 365 

 

                   Phone: 01342 410223 

Web:  www.my-office-365.com     email: sales@my-office-365.com      

 

My Office 365 is brought to you by Microsoft Gold Partner Ballard Chalmers - 

recognised as Microsoft Online Services delivery experts. Our aim is to 

provide small and medium sized organisations with end-to-end services, to 

ensure they can capitalise on the revolutionary Microsoft Office 365 'cloud' 

service, delivered over the Web. 

 

We mainly focus on new clients that are seeking a comprehensive, secure and 

low-cost solution to their IT needs, so they can avoid the time, cost and 

hassle of maintaining their own IT, software and servers. 

 

 A range of Microsoft Office 365 product packages to suit all needs, 

budgets and organisations 

 Costs from just £4.25 per user per month with pay-as-you-go Office 365 

subscription licensing 

 Try before you buy - FREE 30 day trial on the entire range of Microsoft 

Office 365 packages 
 

Click here for your FREE 30 day trial - explore all the features in 

Microsoft Office 365 ‘Plan P’ designed for small businesses.  

You can easily continue using Office 365 beyond the 30-day trial 

period if you choose to purchase. 

Help Resources 

Office 365 Help  Help and how-to information for Office 365 

Office 365 Quick Start Guide  Get started with mail, contacts, calendar, instant 
messaging and document sharing 

Office 365 Community  Forums where you can receive answers to 

questions, report service issues, bugs and 

suggestions and the Office 365 Beta blog and wiki.  

http://www.my-office-365.com/
mailto:sales@my-office-365.com
https://portal.microsoftonline.com/partner/partnersignup.aspx?type=Trial&id=4d0650a0-0796-46cd-a557-76abbb780afd&msppid=3349551
http://g.microsoftonline.com/0BD00en-US/59
http://g.microsoftonline.com/0BD00en-US/135
http://g.microsoftonline.com/0BD00en-US/217
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1: Sign Up and Get Started With Your Office 365 Account 

Sign Up and Access Your Office 365 Account 

Sign up for an account by accessing the URL that My Office 365 has provided to you. Please note that this URL can only be used 

to create a single Office 365 for professionals and small businesses account.  

 

Note: You will need a separate URL to create an Office 365 for enterprises account should you want to do so. 

 

Once you have accessed the URL, enter your country or region, language, name, organization name, e-mail address, and the 

name you want for your new subdomain on the Office 365 beta service: 

 

 

 

Click on Check Availability to confirm that your preferred subdomain name is available. Office 365 also enables customers to 

add a professional domain (such as cohovineyard.com) that they own. The professional domain can be used with e-mail and 

Web addresses. You may consider this a temporary address. 

 

Next, enter a name for your Microsoft Online Services ID and select a strong password: 
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You will be prompted to enter verification text from a picture depicting numbers and/or letters. Next, decide if you want to 

receive offers from Microsoft and Microsoft partners and then click on the I accept button at the bottom of the page to create 

your account. 

 

 

After you successfully sign up, you will receive a welcome e-mail that will tell you how to access your Office 365 account. 

 

If you have any problems during the sign-up process, please contact Mike Mitchell (mikem@waggeneredstrom.com) and Joel 

Steinfeld (jsteinfeld@waggeneredstrom.com). You can also call the Sign Up Support team at (866) 676-6546 between 9 a.m. 

and 5 p.m. Pacific Time. 

Office 365 Prerequisites install these in order: 
1. Microsoft Office Professional Plus (Recommended)  

IMPORTANT: Read all the notes below before installing. 

Microsoft Office 365 is designed to work seamlessly with Microsoft Office 2010 and 2007. For the best experience, 

we recommend installing Office Professional Plus, which is available for subscription purchase through the admin 

portal. 

 Be sure to back up all your important data before participating in this beta program. 

 It is not required to uninstall versions of Office before Office 2010, such as Office 2007 or 2003, before 

installing Office Professional Plus. Office 2010 will need to be uninstalled to use the Office Professional Plus 

full product.  

 If you are offered an upgrade upon installation, Office Professional Plus (with the exception of Microsoft 

Outlook and Microsoft SharePoint Workspace) can co-exist with previous versions of Office by selecting that 

option from within the Customize menu. Microsoft Outlook and Microsoft SharePoint Workspace cannot 

co-exist with previous versions, so you will need to select one version of the program to have installed on 

your computer. 

 Before installing Office Professional Plus, please be sure you have the CD-ROMs/DVDs and product keys 

necessary should you later choose to reinstall your current version of Office. 

 If you choose not to install Office Professional Plus, you can still participate in the beta; however, you will 

not be able to complete all the walkthroughs that involve using the Office applications with Office 365. 

 Please review Microsoft Office Professional Plus system requirements. 

 See additional information in our Frequently Asked Questions. 

https://portal.microsoftonline.com/download/default.aspx
http://g.microsoftonline.com/0BD00en-US/282
http://g.microsoftonline.com/0BD00en-US/283
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2. Using Office Desktop Applications 

For the best experience with Office 365, a set of required components and updates must be applied to each 

workstation. To simplify the installation and maintenance of these components and updates, Microsoft provides an 

installable piece of software — called Office desktop setup — at no charge. These updates are required for all 

workstations that use rich clients (such as Microsoft Office 2010) and connect to the Microsoft Online Services. 

Office desktop setup provides multiple benefits:  

 Preparing PCs to connect to Office 365 by applying required updates  

 Configuring Outlook and Microsoft Lync for use with Office 365 

 

See also: Troubleshoot installation issues for Services Connector 

 

3. Microsoft Lync 

With Lync, you can exchange instant messages, initiate audio and video webconferences, and see presence 

information for your colleagues. You can also set up Lync to enable users to communicate with others outside your 

organization who use Office 365 or Windows Live Messenger. 

 

 

Getting Started with Office 365 
 

Explore the Admin and Home pages 

The Office 365 Admin page will help you navigate many of the important administrative functions of the service. The Home 

page, available to both admin and nonadmin users, will help you navigate many of the services included in Office 365. Please 

familiarize yourself with these pages because they are the starting point for completing many common tasks in the service. 

 

Log on to the Office 365 service, and click on the Admin and Home links at the top of your screen: 

 

 
Note: If the Outlook and Team Site links are dimmed as shown above, these features are still being configured. Check back or 

reload the page in a few minutes. For a complete list of known issues, please view the Release Notes for Office 365 Beta for 

small businesses (English). 

 

 

Verify That You Have Access to Your E-Mail, Team Site and Microsoft Lync 

E-mail 

Access your new Microsoft Office 365 e-mail inbox in your browser through the Microsoft Outlook Web App, a Web-based 

version of Microsoft Office Outlook. In Walkthrough 2 (below), you will learn how to access your Office 365 e-mail through your 

Outlook desktop application. All users will have a free noncustom e-mail address (e.g., joe@contoso.onmicrosoft.com). 

Customers will have the option to use their existing domain name to create professional e-mail addresses (e.g., 

joe@contoso.com).  

 

1. Click on Inbox on the Home page: 

 
 

2. You will be prompted to select your language, time zone, and whether you want to use accessibility features. 

 

https://portal.microsoftonline.com/download/default.aspx
https://portal.microsoftonline.com/download/default.aspx
http://g.microsoftonline.com/0BD00en-US/254
https://portal.microsoftonline.com/download/default.aspx
https://portal.microsoftonline.com/download/default.aspx
http://community.office365.com/enus/office365/w/relnotebetasb/release-notes-for-office-365-beta-for-small-businesses-english.aspx
http://community.office365.com/enus/office365/w/relnotebetasb/release-notes-for-office-365-beta-for-small-businesses-english.aspx
mailto:joe@contoso.onmicrosoft.com
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3. Make your selections, and click on OK to access your Inbox. 

 

 

Team site 

The Office 365 Microsoft SharePoint Online-based team site makes collaboration easier with a password-protected portal to 

share large files both inside and outside your organization. Please verify that you can access your team site from within the 

Web browser.  

 

Click on Team Site on the Home page.  

 
 

Note: If the Team Site link is dimmed, this feature is still being configured. Check back or reload the page in a few minutes. 

 

Microsoft Lync 

With Lync, users can send and receive instant messages, conduct PC-to-PC audio and video calls, conduct online meetings with 

up to 50 participants, and view presence information for their colleagues.  

 

Launch the Microsoft Lync 2010 desktop application, and sign in to the service. Please note: If you have not installed 

Lync, please follow the instructions in Office 365 Beta Pre-Requisites above. 

 

Add a new user to your account 

Create a new user on your account. Save the information for the new user, making a note of the ID and password assigned to 

the user. We recommend that you set up a new user as a test, but you should also feel free to create new users for colleagues 

in your organization who would like to test Office 365.  

 

1. On your Admin page, click on Users under Management on the left side of your screen. 
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2. Now click on the New button and select User. 

 

 
 

 

3. Next enter the name, display name and user name for the account you're creating. 
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4. Optionally, you can add any of these Additional properties by clicking on the blue arrow to expand the entry fields 

list. 

 

 
 

5. When you are done, click on Next to review Settings. 
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6. Leave Assign permissions set to No unless you want to grant this user administrator privileges. At minimum, you 

need to select a user location here and then click on Next to review Licenses. 

 

  
 

7. To provide the new user with access to e-mail, SharePoint and Lync, you must check the box next to Microsoft Office 

365 Beta for small businesses to assign license. Optionally, you can also grant access to a purchased license of 

Microsoft Office Professional Plus. Click on Next to assign a password. 
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8. Here you can enter up to five e-mail addresses to send the new user's temporary password. By default, your e-mail 

address is prepopulated so that you will receive a copy to provide to the user. Add any additional e-mail addresses 

separated by semicolons (up to five recipients), make sure the Send e-mail box is checked, and click on Create. This 

will open a summary page confirming that the account was created and showing you the temporary password.  

 

Note: If you have a number of users to add, you can use the Bulk add users option. This will prompt you to download 

and populate a comma-separated values text file containing all your user data that you then upload and configure. 

 

 
 

Edit the e  user’s setti gs, and reset the user’s password 

Make edits to the user that you created in the previous task. Assign administrator permissions to the user, and add an office 

phone number to the user’s properties. Also, try resetti g the user’s pass ord. Be sure to ake a note of the new password. 

 

1. On the Admin page, click on Users under Management on the left side of your screen. Locate the user that you want 

to manage. 
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2. Click on the user's name to make changes to properties, licenses and other settings. To make the user an 

administrator, go to the Settings section, click on the Yes radio button under Assign permissions and confirm the e-

mail address for service notifications. 
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3. To add details such as an office phone number, click on Properties. 
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4. When you're done making changes, click on the Save button at the bottom of the page.  

 

2: E-Mail, Calendar and Contacts 

Connect Your Office 365 E-Mail to Your Outlook Desktop Application 
Microsoft designed Office 365 to work with the functionality of your desktop version of Outlook e-mail, calendar and contacts. 

You can set up your Office 365 e-mail to be accessed through your Microsoft Outlook desktop application or through Microsoft 

Entourage 2008 for Mac. 

 

1. In Outlook 2010, open the File tab and click on the Add Account button. 

 
 

2. This opens the Add New Account dialog box. 
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3. Enter your e-mail address and password, and click on Next. When the account is done auto-configuring, click on 

Finish. 

 

Set Up and Access E-Mail, Calendar and Contacts on a Mobile Device 
Office 365 gives you anywhere access to your e-mail, important documents, contacts and calendar on nearly any device — 

including iPhone, Android, BlackBerry
4
 and Windows Mobile phones. Office 365 also automatically updates your e-mail, 

calendar and contacts across supported devices
5
 For assistance, read the Connect a Mobile Device to E-mail in Office 365 Beta 

help article. 

 

 

Access and Send E-Mail Through Outlook and Outlook Web App  
Microsoft Outlook Web App is a Web-based version of Outlook that provides the familiar, rich functionality and experience you 

are accustomed to from the desktop version of Microsoft Outlook. If you are limited by low bandwidth, Outlook Web App is 

optimized so it minimizes data and bandwidth use. Cross-browser support for Safari, Firefox, Chrome and Internet Explorer 

ensures that wherever you are connected to the Internet — at home, at the office or on the road — you can access your e-mail 

o e you’ e follo ed the steps a o e to add your a ou t. 
 

Log in to Office 365, and click on Outlook at the top of the screen to access Outlook Web App or launch your Outlook 

desktop application. 

 

 

Share Calendars Through Outlook or Outlook Web App and Send a Meeting Request 
“hari g ale dars ith olleagues akes s heduli g easier ith the a ility to see olleagues’ a aila ility fro  your Outlook 
calendar. When you set up a meeting request in Outlook or Outlook Web App, you can use the calendar to see your schedule 

                                                      
4
 Users of Blackberry Internet Service get push e-mail and can add calendar and contacts to their Blackberry device through a wired 

sync with Outlook on the PC 
5
 Access from mobile devices depends on carrier network availability. 

http://g.microsoftonline.com/0BD00en-US/219


  

Microsoft Office 365 for Professionals and Small Businesses | 19 

and to find times that your colleagues are available as well. You can choose to share only whether you are available or not, or 

the details of your calendar appointments. Note: You can only see the availability of your colleagues who are also on your 

Microsoft Office 365 Beta accounts. You can still send a meeting request to anyone, but you won't see their free/busy 

information unless they are in the beta and have been added as users for your organization.  

 

In Outlook or Outlook Web App, create a new meeting request. You will be able to view the calendars of any users 

that you have created in Office 365 by adding them to the meeting request and clicking on Scheduling Assistant.  

 

 
 

 

 

3: Storing and Sharing Documents with SharePoint Online Team Sites 

Explore the Navigation of Your Team Site 
Office 365 makes it easy for you to share documents with colleagues, customers and partners both inside and outside your 

organization through SharePoint Online. The team site page will help you navigate many of the important benefits and 

capabilities of SharePoint Online. Please fa iliarize yourself ith the a igatio  ri o  at the top of your s ree . The utto s 
you use to perform the most common team site actions are found here. 

  

Log in to Office 365 and click on Team Site. Explore the navigation ribbon at the top of your screen. Click on the Page 

tab to open editing tools. 

 

 
 

The buttons you use to perform the most common action are found here. Try making the following basic changes to your team 

site:  
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Change the Color and Size of the Text 

1. Click on the Edit button or icon on your navigation ribbon to open the Editing Tools. 

 

 
 

2. Select the text you want to change and then click on the Font Size selector on the ribbon. 

 

 
 

3. To change the color, select your text and click on the Font Color selector. 

 

 
 

Add an Image to the Page 

1. While still in Edit mode, click in the body of the page where you want to add the image. Click on the Insert tab and 

then on the Picture button. 
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2. Select the source of the picture you want to add — for example, From Computer — to open a dialog box that lets you 

browse or paste the address of the image file. 

 
 

Add a Table to Your Page 

1. This is similar to adding a picture. While in Edit mode, click in the body of the page where you want to add the table. 

Click on the Insert tab and then on the Table button. 

 

 
 

2. Now select the dimensions you want from the drop-down menu and click to insert it. 
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When you're done making changes to your team site page, click on the Save icon or go to the Format Text tab and click on Save 

& Close. If you do NOT want to keep your changes, click on the Check Out button and select Discard Check Out: 

 

 

 
 

 

Upload a Document to Your Team Site 
A team site gives your organization a single, password-protected location to find the very latest file or document version. Once 

you upload a document to a team site, you can access it from your Web browser, Microsoft Office desktop applications and 

supported mobile device. 

 

1. On your Team Site, click on Site Actions and select New Document Library. 

 

 

 
 

2. Give your library a Name and optionally add a Description and adjust any settings. 
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3. Click on Create and then on Add document when your library appears. 

 

 
 

 

4. Add any file from your desktop and then click on OK. 
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Share Your Team Site outside Your Organization 
As an administrator, you can grant access to users both inside and outside your organization to view and make changes to 

documents and data. By default, users within your organization will be granted access to your team site. Use an existing non-

Office 365 e-mail account (e.g., Yahoo, Gmail or Hotmail account) to test sharing your team site with a user outside your 

organization. 

 

1. In your team site, click on Site Actions in the top left corner of your screen then click on Share Site.  
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2. Type the nonemployee e-mail address in the group you want to add it to, and click on Share.  

 

 
 

 

3. Verify that the external user can access the team site. Then send them a link to the document you uploaded in the 

task above and start collaborating. 

 

Remove a User From a Team Site 
1. Click on Site Actions and then on Site Settings. 
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2. Click on Site permissions under Users and Permissions. 

 

 
 

3. Find the user you want to remove, click on the checkbox next to the name, click on Actions and select Remove Users 

from Group. 
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Create a List Then Create a New View of This List 
You can create a list on your team site to store, share and manage team information. For example, you can create a task list to 

track work assignments or track team events on a calendar. Try creating a basic task list on your team site. 

 

1. On your Team Site, click on the Site Actions menu and then click on More Options.  
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2. Click on List in the left navigation, and choose the type of list you want to create and give it a title. 

 

 
 

 

3. Click on Create.  

 

 
 

 

4. You can now add list items, configure different views on this list, set up alerts, subscribe via RSS, and take the content 

offline with Office. 
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Create a New Team Site 
You can create a new team site for a specific team or project. There are several types of site templates to give you a head start 

on creating a new site.  

 

1. On your Team Site, click on the Site Actions menu and then click on New Site. 

 

 
 

2. Choose the Express Site for a basic Team Site, or click on the Browse All tab for a variety of site choices including 

Document Workspace, Meeting Workspace, Blog and more. 
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3. Make your choice, enter a title and URL name, and click on Create. 

 

View Your Team Sites on Your Mobile Device 
You can view your SharePoint Online team sites from your mobile device browser. SharePoint Online supports mobile access to 

SharePoint pages and list data. Users of mobile devices navigate to the same URLs as do users of desktop browsers. The mobile 

device is automatically redirected to a version of the page that is optimized for mobile devices. 

 

You can access a mobile page of an Office 365 site through an ordinary Web browser, such as Internet Explorer, by 

appending ?Mobile=1  to the end of the URL of the page. 
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4: Explore Office Web Apps and Using Team Sites with Microsoft Office 

Edit a Document on Your Team Site Using Office Web Apps 

 

With Office 365, you can view and edit Microsoft Word, Excel, PowerPoint and OneNote documents directly from your Web 

browser using Office Web Apps. Office 365 is the only set of Web-enabled tools designed to be fully compatible with Microsoft 

Outlook, Word, PowerPoint and Excel. Open one of the Office documents that you uploaded to your team site in high fidelity, 

and update it with Office Web Apps. 

 

1. Go to your team site, and click on one of the Office documents you uploaded to open it, or hover over the title and 

select View in browser or Edit in browser from the drop-down menu.  

 
If you just click on the document in SharePoint, the default behavior is for the document to open in reading view. You will 

notice that the document looks exactly as intended. When you switch to Editing view, the document might change. However, 

the content is not altered. The paramount design goal for the Office Web Apps was to provide people with consistent, high-

fidelity experiences. Documents maintain integrity of content, features and formatting, no matter which Office application they 

were created in or shared with (desktop, Web or mobile). They may look slightly different in different experiences because of 

different feature sets, but the information and structure are maintained.  

 

2. Make some edits, and note that the file is being auto-saved as you work. 

Simultaneously Edit a Document With a Colleague (Co-Author) Using Office Web Apps 

Office Web Apps allow you and your team to simultaneously edit the same spreadsheet or OneNote notebook from your 

individual locations. For example, you can work on one section in an Excel spreadsheet while a colleague works on another 

section in the same file at the same time. 
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1. If you ha e ’t already, add a olleague as a  Offi e 3  user using the steps outlined in Walkthrough 1 above.  

2. Add an Excel spreadsheet or a OneNote notebook to your team site then try to edit the file at the same time as your 

colleague. Note that as you ork you a  see your olleague’s a e ithi  the do u e t a d the area the colleague 

is working on. 

Add a Shortcut to a SharePoint Library in Microsoft Office 
You a  ope , edit a d sa e do u e ts that are stored i  your “harePoi t O li e tea  site’s do u e t li rary dire tly fro  
your Microsoft Office desktop applications by creating a shortcut to a SharePoint library in Microsoft Office.  

 

1. In your team site, click on Documents. If you don't have a Documents Library, follow the steps in Walkthrough 3 to 

create one.  

 

 
 

2. At the top of your screen, click on Library under Library Tools.  

 

 
 

3. Click on Connect to Office in the ribbon at the top of your screen. 

 

 
 

Access Team Site Documents Offline Using Microsoft SharePoint Workspace 2010 
Microsoft SharePoint Workspace 2010 is available in Office Professional Plus. Workspace 2010 allows you to work with your 

SharePoint team sites, document libraries and lists when you’re offli e y reati g a sy hro ized opy of your tea  site o  
your computer. Synchronization of changes between your computer and the SharePoint server are handled smoothly and 

efficiently — o ly tra sferri g the ha ges that you’ e ade, ot the e tire document each time. 

 

1. In your team site, click on Site Actions and then click on Sync to SharePoint Workspace. 
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2. If SharePoint Workspace 2010 does not open, you may need to run and configure it. Open your Windows Search box 

and type SharePoint  to locate it. Once it's set up, try again.  
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3. Once the site is initially synchronized on your desktop, try adding new documents or list items from within SharePoint 

Workspace 2010 and note how they automatically synchronize back to the team site. 
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5: Databases 

Publish a Microsoft Access Desktop File as a SharePoint Online, Web-Based Database (List) 
Access 2010 is a database application included in Office Professional Plus, which you downloaded in Walkthrough 1. You can 

use Office 365 to publish Access databases to your SharePoint Online environment, allowing you to securely share your data 

with others, view and edit your database directly from your Web browser, and create database applications that don't require 

Access on the desktop to use. 

 

1. Start Access 2010, click on the File tab and open a database such as the sample Wine Inventory Database.  

 

 

 
 

2. Go back to the File tab, and click on Save & Publish on the left navigation and then select Publish to Access Services. 
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3. Enter the URL path to your team site. Be sure to omit any filenames and unnecessary paths 

For example, http://cohovineyard.spoppe.com/TeamSite/SitePages/Home.aspx would be shortened to 

http://cohovineyard.spoppe.com/TeamSite. 
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4. Click on the Publish to Access Services button. Once complete, the SharePoint Online database becomes the primary 

sour e of data a d the desktop opy re ai s i  sy  ut is o lo ger pri ary it’s se o dary . Visit your team site, 

and click on and select View All Site Content. 
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5. Scroll down to Sites and Workspaces, and click on the name of your database to open it. 

 

 
 

6. Click on Options at the top to Share Site and adjust Site Permissions and Settings. 
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Once granted access, users can view, edit and search the database from anywhere. 

 

 

6: Public Websites 

Design a Basic Public Website Using the SharePoint Online Site Designer Tool 
Microsoft SharePoint Online comes with two types of sites — team sites and public sites. The public site is a lightweight, public-

facing website that provides your customers with your company information, such as your products, services and contact 

information. With Office 365 for small businesses and professionals, you get a public-facing site that can be easily designed and 

customized to create and manage a professional-looking public Web presence. 

 

1. In SharePoint Online, click on the Website tab located on the top left corner of your screen (NOT the View Website 

link).  

 

 
 

2. Click on Home to launch the Site Designer tool. 
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3. Click on the Design tab to begin designing your public e site’s home page.  

 

 

 

4. Use the ribbon to change the Style and Theme of your website.  
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5. Click on Text to customize your header. Make other changes/additions to your website.  
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6. Click on File and Save & Publish to record your changes.  

 

 
 

7. View what your site will look like to the public by going to the Home tab and then clicking on View. 
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7: Instant Messaging, Video Chat and Online Meetings 

Sign In to the Microsoft Lync Client 
Microsoft Lync Online is a next-generation online communications service that connects people in new ways, anytime from 

virtually anywhere. Lync Online provides rich and intuitive communications capabilities including presence, instant messaging, 

audio-video calling, and a rich online meeting experience that supports audio-, video- and webconferencing. 

 

1. Launch Lync 2010, which you downloaded in Walkthrough 1. Enter your credentials and then click on Sign In.  

 

 
 

You may be prompted to install additional software to sign in to Office 365. This additional piece of software is the 

Office desktop setup described in Walkthrough 1. If prompted, install it then click on Sign In again. 

 

 
 

2. Set your presence so that your olleagues k o  you’re a aila le. 
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3. Click on the default photo to add a custom photo and personalize your contact information. 
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Locate and Organize Your Contacts 
You can search for contacts by title, team or other keyword as well as name. You can organize them in handy groups and 

display the  i  a ariety of ays, i ludi g their urre t status su h as o li e  or a ay  or their relatio ship to you such as 

olleagues  or frie ds a d fa ily . 
 

1. Use the Find a contact search box to locate a perso  i  your orga izatio  that you’d like to add to your Co ta t List.  

 

 
 

2. Click on the Plus Sign next to that person's contact to add him or her to a group. 

 

 
 

3. Then add the contact to a group that corresponds to how you work. 
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Send an Instant Message to One Contact and Then Add More People to the Conversation 

O e you’ e lo ated a o ta t a d see  that he or she is a aila le, it’s si ple to instant message that person then add 

additional people to the conversation as needed.  

 

1. Double-click on a contact to start an instant message session.  

 

 
 

2. Drag another contact from your company to add to the conversation. Note: You can only communicate one-on-one 

with Windows Live Messenger contacts. You will not be able to drag other Windows Live Messenger contacts into an 

existing instant messaging conversation. 

Initiate an Instant Messaging Conversation From SharePoint Online, Office Web Apps or Office 
Your Contact List — as well as Lync features such as the presence indicator, instant messaging and screen sharing — are now 

directly accessible from Outlook, Word, PowerPoint, Excel and SharePoint Online team sites. This enables you to see the 

presence of those you are working with and quickly start collaborating with them without having to change applications. 

 

1. When viewing e- ail essages i ludi g i  the Pre ie  pa e , you’ll see prese e for o ta ts i  the Fro , To a d 
CC fields. Pointing to or right-clicking on the contact displays the contact card and available commands.  

 

2. Try sharing your desktop or starting a video call or online meeting. 
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Schedule an Online Meeting 
Microsoft Lync Online makes it easy for users to create, moderate and join conferences with internal and external users. A rich 

user experience and a unified interface make it easy for workers to collaborate frequently and effectively, even when time or 

distance prevents in-perso  eeti gs. With Ly  O li e, it’s easier to s hedule a  o li e eeti g a d i ite additio al people 
o e the eeti g has started. Parti ipa ts o  ha e a lo y  i  hi h to ait u til the eeti g orga izer arrives, and the 

orga izer has e  ays to e sure a s ooth a d produ ti e eeti g. You’ll e a le to olla orate o  a file or hite oard, share 

a view of your desktop, deliver a PowerPoint presentation, and much more. 

 

Further, there are two new meeting applications so that your out-of-organization contacts can fully participate in your online 

meetings: Lync Web App and Lync Attendee. Use the Online Meeting Add-in for Microsoft Outlook (which was installed with 

Lync 2010) to set up a meeting with colleagues in different locations and organizations.  

 

1. In Outlook 2010, click on the Home tab, click on New Items, then click on Online Meeting.  
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2. If you already have an Outlook appointment or meeting request open, you can make it an online meeting by clicking 

on the Online Meeting button. 
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Conduct a Meeting 
As the meeting leader, you can control who enters the meeting and who has permission to share content. The meeting 

conversation window is designed to help you lead presentations and keep the meeting on course.  

Note: Meeting participants inside and outside your organization will have access to audio and video during the meeting through 

their PCs. Dial-in conferencing requires a separate agreement with an audioconferencing provider. Additional information 

concerning dial-in conferencing will be made available later in the beta program.  

 

In the Outlook invitation, click on Join online meeting or the meeting link. You can also join a meeting by clicking on the Join 

Online button in the Outlook pop-up Meeting Reminder.  

 

 


